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Introduction

After you have set up your Epson Stylus® C120 Series printer as described on the 
Start Here sheet, turn here to:

■ Load paper

■ Get the basic steps for printing from your computer

■ Perform routine maintenance

■ Solve simple problems

For additional instructions, see the on-screen User’s Guide by clicking the C120 
Series User’s Guide icon on your desktop.

Please follow these guidelines as you read your instructions:

Warning: 

Warnings must be followed carefully to avoid bodily injury.

Caution: 

Cautions must be observed to avoid damage to your equipment.

Note: 

Notes contain important information about your product.

Tip: 

Tips contain hints for better printing.

Links to online 
resources

Movies and 
featured topics

Contents of
on-screen

manual
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Loading Paper

1. Open the paper support.

2. Open the output tray and pull out the extensions.

3. Squeeze the tab on the edge guide and slide it left.
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4. Insert the paper, printable side up, against the right edge guide and beneath 
the tabs. (The printable side is whiter or brighter on some papers.) Always 
load paper short edge first, even for landscape printing.

5. Slide the left edge guide against the left edge of the paper (but not too tightly).

You can load up to 80 sheets of plain paper and up to 20 sheets of matte or photo 
paper (see the User’s Guide for capacity guidelines on other paper types).

Note: 

The type of paper you choose affects the way your printout looks, so be sure to select 
the correct paper for your job. If you are just printing a rough draft, plain paper is fine. 
However, for the best results, you’ll want to use one of Epson’s special ink jet papers 
designed for your printer.

Using Special Papers

Epson® offers a wide array of high quality papers, making it easy to maximize the 
impact of your presentations and other projects.

Paper type Size

Part 

number

Sheet 

count

Epson Bright White Paper Letter (8.5 × 11 inches) S041586 500

Epson Photo Paper Glossy Borderless 4 × 6 inches S041809
S042038

50
100

Letter (8.5 × 11 inches) S041141
S041649
S041271

20
50
100
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You can purchase genuine Epson ink and paper at Epson Supplies CentralSM at 
www.epson.com/ink (U.S. sales) or www.epson.ca (Canadian sales). You can also 
purchase supplies from an Epson authorized reseller. To find the nearest one, call 
800-GO-EPSON (800-463-7766).

Epson Premium Photo Paper 
Glossy

Borderless 4 × 6 inches S041808
S041727

40
100

Borderless 5 × 7 inches S041464 20

Borderless 8 × 10 inches S041465 20

Letter (8.5 × 11 inches) S041286 
S041667

20
50

Epson Ultra Premium Photo Paper 
Glossy

Borderless 4 × 6 inches S041934 50

Letter (8.5 × 11 inches) S041935 20

Epson Premium Photo Paper Semi-
gloss

Borderless 4 × 6 inches S041982 40

Letter (8.5 × 11 inches) S041331 20

Epson Presentation Paper Matte Letter (8.5 × 11 inches) S041062 100

Legal (8.5 × 14 inches) S041067 100

Epson Premium Presentation Paper 
Matte

Borderless 8 × 10 inches S041467 50

Letter (8.5 × 11 inches) S041257 50

Epson Premium Presentation Paper 
Matte Double-sided

Letter (8.5 × 11 inches) S041568 50

Epson Photo Quality Self-adhesive 
Sheets

A4 (8.3 × 11.7 inches) S041106 10

Epson Iron-on Cool Peel Transfer 
Paper

Letter (8.5 × 11 inches) S041153 10

Paper type Size

Part 

number

Sheet 

count
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Basic Printing

This section describes the basic steps for printing a document or photo stored on 
your Windows® or Macintosh® computer. 

Note: 

For detailed instructions on printing, see the on-screen User’s Guide.

Before you start, make sure you’ve installed your printer software and connected 
the Epson Stylus C120 Series printer to your computer as described on the 
Start Here sheet.

Tip: 

It’s a good idea to check Epson’s support web site periodically for 
free updates to your Epson Stylus C120 Series printing software. 
Open your on-screen User’s Guide and select Download the Latest 
Software or visit Epson’s support website at epson.com/support. 
Download instructions are posted for your convenience.

Printing in Windows

1. Load paper (see page 4).

2. Open your document or photo in a Windows program.

3. Open the File menu and select Print. You see a window like this one:

Click here to open your 
printer software

Select Epson Stylus C120 Series
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4. Make sure Epson Stylus C120 Series is selected, then click the Preferences 
or Properties button.

(If you see a Setup, Printer, or Options button, click it. Then click 
Preferences or Properties on the next screen.)

5. On the Main tab, select the basic print settings:

Make sure you choose the correct paper Type setting for the paper you are 
using (see page 12 for details).

Note: 

For more information about print settings, click the ? or Help button.

6. For more printing options, click the Advanced tab. 

Note: 

For more information about advanced settings, or instructions on saving them as a 
group so you can reuse them later, click ? or Help. 

7. If you want to change the layout settings, click the Page Layout tab and 
select settings as necessary.

Select the type of document you’re printing 
(choose Photo or Best Photo for pictures)

Select your 
document 
Orientation

Select your 
paper Size

Select your 
paper Type

Click here for 
borderless 
photos
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8. Click OK to save your settings, then click OK or Print to start printing. This 
window appears and shows the progress of your print job.

Printing With Macintosh OS X

1. Load paper (see page 4).

2. Open your document or a photo in an application.

3. Select Page Setup from the File menu. Make the following settings:

* For borderless printing, choose a Sheet Feeder - Borderless option in the 
Paper Size list for your paper size (US Letter, 8 × 10 in, 4 × 6 in, or 5 × 7 in).

4. Click OK to close the Page Setup window.

Cancel printing

Check ink 
cartridge status

Select Stylus C120

Select your Paper Size* 

Select your document 
or image orientation

Pause or resume 
printing
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5. Select Print from the File menu. You see a window like this one:

6. Choose Print Settings from the pop-up menu and select the following 
settings as necessary:

Note: 

In certain programs, you may need to select Advanced before you can select Print 
Settings. For more information about printer settings, click the ? button.

7. Depending on your settings, you can choose these other options from the 
pop-up menu:

■ Copies & Pages: Select the number of copies you want, or a page range.

■ Layout: Select page layout options.

■ Scheduler: Schedule your print job to print at a later time.

■ Paper Handling: Select page printing options, such as Reverse print 
order.

Select Print Settings

Select Stylus C120

Select your Media 
Type (see page 12)

Select Color or Black ink

Select higher quality 
or faster printing
(if available)

Select 
Automatic mode
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■ ColorSync or Color Management: Select ColorSync® or adjust the 
color controls, change the gamma setting, or turn off color adjustments in 
the printer software.

■ Cover Page (OS X 10.4.x only): Add a cover page before or after the 
document.

■ Expansion: Reduce or enlarge the image size for borderless printing.

■ Summary: View a list of all your selections.

8. Click the Advanced button to change additional settings.

Note: 

For more information on advanced settings, or instructions on saving them as a 
group so you can reuse them later, click ?.

9. Click Print.

10. To monitor the progress of your print job, click the  printer icon when it 
appears in the dock on the bottom of your desktop. 

If you’re using OS X 10.2.x, click the  Print Center icon instead, then 
double-click Stylus C120 in the Printer List window.

You see a screen like this:

11. When you’re finished, close the printer window or Print Center.

Cancel 
printing

Select the 
print job
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Selecting the Correct Paper Type

Select the correct Type (see page 8) or Media Type (see page 10) setting in your 
printer software:  

For this paper Select this setting

Plain paper
Epson Bright White Paper
Epson Presentation Paper Matte

Plain Paper/Bright White Paper

Epson Ultra Premium Photo Paper Glossy Ultra Premium Photo Paper 
Glossy

Epson Premium Photo Paper Glossy Premium Photo Paper Glossy

Epson Photo Paper Glossy Photo Paper Glossy

Epson Premium Photo Paper Semi-gloss Premium Photo Paper Semi-
Gloss

Epson Premium Presentation Paper Matte
Epson Premium Presentation Paper Matte 
Double-sided
Epson Photo Quality Self-adhesive Sheets
Epson Iron-on Cool Peel Transfer Paper

Premium Presentation Paper 
Matte

Envelopes Envelope
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Maintaining Your Printer

If you notice a decline in print quality, follow the instructions in this chapter for:

■ “Checking the Print Head Nozzles” (see below)

■ “Cleaning the Print Head” on page 14

■ “Checking the Ink Cartridge Status” on page 15

■ “Replacing Ink Cartridges” on page 16

Checking the Print Head Nozzles

If your printouts are faint or have gaps in them, some of the nozzles in the print 
head may be clogged or ink may be running low in one or more of the ink 
cartridges. Follow the steps below to check the print head nozzles.

1. Turn off the printer.

2. Load letter-size paper in the sheet feeder.

3. Press the ) paper and P power buttons together and hold them down for 
about 3 seconds. The printer turns on and prints a test pattern.

If the pattern does not look good, try cleaning the print head as described on the 
next page. 

Print head nozzles are clean:

Print head needs to be cleaned:
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Cleaning the Print Head

If your printouts are unexpectedly light or faint, or you notice light or dark bands 
across your printout, you may need to clean the print head. This unclogs the 
nozzles so they can deliver ink properly. Run a nozzle check as described on 
page 13 to see if the print head needs cleaning.

Note: 

Print head cleaning uses ink, so clean it only if quality declines and the nozzle check 
indicates that the print head needs to be cleaned.

If the H ink light comes on or flashes, you cannot clean the print head as described 
below. In this case, replace the appropriate ink cartridge first (see page 16) or clean the 
print head using the utility in the printer driver.

1. Make sure the printer is on and the H ink light is off.

2. Hold down the H ink button for 3 seconds until the P power light starts 
flashing. The printer runs a head cleaning cycle.

Caution: 

Never turn off the printer while head cleaning is in progress. You may damage it.

3. When the P power light stops flashing, run a nozzle check (as described on 
page 13) to verify that the print head is clean. 

4. If there are still gaps or lines, or the test patterns are faint, run another 
cleaning cycle and check the nozzles again.

Note: 

If you don’t see any improvement after cleaning the print head up to 4 times, turn off 
the printer and wait overnight. This lets any dried ink soften. Then try cleaning the print 
head again. If quality still does not improve, one of the ink cartridges may be old or 
damaged and needs to be replaced (see page 16).

Tip: 

If you do not use your printer often, it is a good idea to print a few pages at least once a 
month to maintain good print quality.
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Checking the Ink Cartridge Status

When the H ink light starts flashing, one or more cartridges are low on ink. When 
the H ink light stays on, you need to replace the cartridge(s). 

Caution: 

You cannot print if one or more cartridges are expended. Leave the expended 
cartridge(s) installed until you have obtained a replacement, or the ink remaining in the 
print head nozzles may dry out.

A window may appear on your screen if you try to print when ink is low. On a 
Windows computer that is connected to the Internet, you may see a screen asking 
if you want to receive ink offers and other updates from Epson. Click Accept or 
Decline to continue. 

Note: 

To disable checking for ink offers or updates from Epson, see the instructions in your 
on-screen User’s Guide.

You can purchase genuine Epson ink and paper at Epson Supplies Central at 
www.epson.com/ink (U.S. sales) or www.epson.ca (Canadian sales). You can also 
purchase supplies from an Epson authorized reseller. To find the nearest one, call 
800-GO-EPSON (800-463-7766). Use these part numbers when you order or 
purchase new ink cartridges:

Note: 

The Epson Stylus C120 Series requires two black ink cartridges. You must use the 
number 68 (high capacity) black ink cartridges, not the number 69 (standard capacity) 
ones.

We recommend that you use genuine Epson cartridges and do not refill them. The use 
of other products may affect your print quality and could result in printer damage.

Cartridge yields vary considerably based on images printed, print settings, paper type, 
frequency of use, and temperature. For print quality, a small amount of ink remains in 
the cartridge after the “replace cartridge” indicator comes on. The printer ships with full 
cartridges and part of the ink from the first cartridges is used for priming the printer.

For best printing results, use up a cartridge within six months of opening the package. 

Color Part number

Black 68 (high capacity; two required)

Cyan 69

Magenta 69

Yellow 69
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Replacing Ink Cartridges

Make sure you have a new ink cartridge before you begin. Once you start replacing 
a cartridge, you must complete all the steps in one session.

1. Make sure the printer is on.

2. Open the printer cover.

3. Press and release the H ink button. The P power and H ink lights flash. 

If one of the cartridges is low or expended, the printer moves that cartridge to 
the _ expended ink mark. Go to step 4.

If no cartridges are low or expended, the ink cartridge holder moves to the ink 
replacement position. Go to step 4.

Note: 

Do not hold down the H ink button for more than 3 seconds or the printer will start 
to clean the print head.

Caution: 

Do not move the print head by hand; this may damage the printer. Always press 
the H ink button to move it.
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4. Press the H ink button again. 

■ If another cartridge is low or expended, it moves to the _ expended ink 
mark. 

■ Once the printer identifies all of the low or expended ink cartridges, the 
print head moves to the ink cartridge replacement position.

5. Open the cartridge cover.

Caution: 

Never attempt to open the cartridge cover when the print head is moving. Wait 
until the cartridges have moved to the replacement position.

6. Squeeze the tab at the back of the cartridge and lift it straight out. Dispose of 
it carefully. Do not take the used cartridge apart or try to refill it.
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Warning: 

If ink gets on your hands, wash them thoroughly with soap and water. If ink gets 
into your eyes, flush them immediately with water. Keep cartridges out of the 
reach of children.

7. Before you open the new ink cartridge package, shake it four or five times. 
Then remove it from the package.

Caution: 

Do not touch the green chip on the front of the cartridge. This can damage the ink 
cartridge.

8. Remove the yellow tape from the bottom of the ink cartridge. 

Caution: 

If you do not remove the yellow tape before installing the ink cartridge, print quality 
may decline or you may not be able to print.

Caution: 

Do not remove any other seals from the cartridges.
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9. Place the new ink cartridge into the cartridge holder and push it down until it 
clicks into place.

10. Once you replace any other cartridges that need replacing, close the ink 
cartridge cover and press it until it clicks into place.

11. Close the printer cover.

12. Press the H ink button. The printer begins charging ink and the P power 
light starts flashing. This takes about 1 1/2 minutes. When it’s finished, the 
P power light stops flashing and remains on, and the H ink light goes out.

Caution: 

Never turn off the printer while the P power light is flashing or you’ll waste ink.

If you removed a low or expended ink cartridge, you cannot reinstall and use the 
cartridge.

Note: 

If the H ink light stays on (not flashing), the ink cartridge may not be installed 
correctly. Press the H ink button again and reinstall the ink cartridge until it clicks 
into place.
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Solving Problems

If you have a problem with your Epson Stylus C120 Series printer, check the lights 
on the control panel to diagnose the cause.

You can also check “Problems and Solutions” on page 21 for basic troubleshooting 
suggestions, or double-click the User’s Guide icon on your computer desktop for 
more detailed help. 

Error Indicators

Light status Cause Solution

The printer cover is 
open.

Close the printer cover.

No paper is loaded in 
the sheet feeder.

Load paper in the sheet 
feeder. See page 4.

Multiple pages have 
been fed into the sheet 
feeder.

Press the ) paper 
button to eject the 
paper. Then reload the 
paper; see page 4.

Paper is jammed. See page 22.

An ink cartridge is 
running low on ink.

See page 15.

P H )
Flashing Flashing 

fast
Flashing 

fast

Flashing Off On
P H )

Flashing Off Flashing
P H )

On Flashing Off
P H )
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Problems and Solutions

Check the solutions below if you’re having trouble using your printer.

Paper Feeding Problems

■ Make sure the paper size settings are correct for the paper you loaded.

■ Make sure your paper is loaded short edge first and is positioned against the 
right edge guide with the left edge guide against its left side. Don’t load paper 
above the arrow mark inside the left edge guide.

■ If paper doesn’t feed, remove it from the sheet feeder. Flip through the stack to 
separate the sheets a little. Then reload the paper against the right edge guide, 
and slide the left edge guide against the paper (but not too tightly). Make sure 
the paper is not in front of the feeder guard.

■ Do not load too many sheets at once (up to 20 sheets of photo or matte paper 
and 80 sheets of plain paper). See the User’s Guide for more information.

An ink cartridge is 
expended or not 
installed correctly.

See page 15.

A part needs to be 
replaced.

Contact your local 
authorized servicer or 
contact Epson for a 
referral; see page 23.

There is a problem with 
the printer.

Turn the printer off and 
then back on. If the 
error does not clear, 
contact your local 
authorized servicer or 
contact Epson for a 
referral; see page 23.

Light status Cause Solution

On On Off
P H )

Off Flashing 
fast

Flashing 
fast

P H )

Off Flashing Flashing
P H )



22 Solving Problems

■ If paper is jammed, follow these steps to clear the jam:

1. Press the ) paper button to eject the jammed paper. If the jammed paper 
is not ejected, go to the next step.

2. If the paper is stuck near the sheet feeder or output tray, gently pull it out.

If the paper is stuck inside, press the P power button to turn off the 
printer. Open the printer cover and remove any paper inside, including 
any torn pieces. Do not pull it out backward; this can damage the sheet 
feeder. Close the printer, then turn it back on.

Print Quality Problems

If you have any problems with the print quality, try these solutions:

■ Load the paper printable side up (usually the whiter, brighter, or glossy side).

■ Make sure your paper isn’t damp or curled.

■ Use a support sheet with special paper or load your paper one sheet at a time. 
Remove sheets from the output tray so not too many collect at a time.

■ Make sure the type of paper you loaded matches the paper size and paper type 
settings in your printer software (see page 12). 

■ For the best print quality, use Epson special paper (see page 5) and genuine 
Epson ink cartridges (see page 15).

■ If you notice light or dark bands across your printouts or they are too faint, 
you may need to clean the print head. This unclogs the nozzles so they can 
deliver ink properly. Run a nozzle check as described on page 13 to see if the 
print head needs cleaning.

■ Clean the print head as described on page 14.

■ If you notice jagged vertical lines, you may need to align the print head. See 
your User’s Guide for instructions.

■ The ink cartridges may be old or low on ink (see page 16 for instructions on 
replacing an ink cartridge).



Where To Get Help 23

Where To Get Help

Epson Technical Support

Epson provides these technical support services:

Internet Support
Visit Epson’s support website at epson.com/support and select your product for 
solutions to common problems. You can download drivers and documentation, 
get FAQs and troubleshooting advice, or e-mail Epson with your questions.

Speak to a Support Representative
Before you call Epson for support, please have the following information ready:

■ Product name (Epson Stylus C120 Series)

■ Product serial number (located on the label in back)

■ Proof of purchase (such as a store receipt) and date of purchase

■ Computer configuration

■ Description of the problem

Then call:

■ U.S.: (562) 276-7525, 6 AM to 8 PM, Pacific Time, Monday through Friday, 
and 7 AM to 4 PM, Saturday

■ Canada: (905) 709-2567, 6 AM to 6 PM, Pacific Time, Monday through 
Friday

Toll or long distance charges may apply.

Purchase Supplies and Accessories

You can purchase genuine Epson ink and paper at Epson Supplies Central at 
www.epson.com/ink (U.S. sales) or www.epson.ca (Canadian sales). You can also 
purchase supplies from an Epson authorized reseller. To find the nearest one, call 
800-GO-EPSON (800-463-7766).
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Other Software Technical Support

Software Telephone/Fax Online and E-mail

ArcSoft 
PhotoImpression

(510) 440-9901 
8:30 AM - 5:30 PM, Pacific 
Time, Monday - Friday
Fax: (510) 440-1270

www.arcsoft.com
support@arcsoft.com
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Notices

Important Safety Instructions

Before using your Epson Stylus C120 Series printer, read and follow these safety 
instructions:

■ Be sure to follow all warnings and instructions marked on the printer.

■ Use only the type of power source indicated on the printer label.

■ Use only the power cord that comes with the printer. Use of another cord may cause 
fires or shock. Do not use the cord with any other equipment.

■ Place the printer near a wall outlet where the plug can be easily unplugged.

■ Do not let the power cord become damaged or frayed.

■ If you use an extension cord with the printer, make sure the total ampere rating of the 
devices plugged into the extension cord does not exceed the cord’s ampere rating. 
Also, make sure the total ampere rating of all devices plugged into the wall outlet does 
not exceed the wall outlet’s ampere rating.

■ Avoid locations that are subject to rapid changes in heat or humidity, shocks or 
vibrations, or dust.

■ Leave enough room around the printer for sufficient ventilation. Do not block or 
cover openings in the printer case or insert objects through the slots.

■ Do not place the printer near a radiator or heating vent or in direct sunlight.

■ Place the printer on a flat, stable surface that extends beyond its base in all directions. 
It will not operate properly if it is tilted or at an angle. 

■ Make sure the back of the printer is at least 4 inches (10 cm) away from the wall.

■ Do not spill liquid on the printer.

■ Except as specifically explained in your documentation, do not attempt to service the 
printer yourself.

■ Unplug the printer and refer servicing to qualified service personnel under the 
following conditions: if the power cord or plug is damaged; if liquid has entered the 
product; if the product has been dropped or the case damaged; if the product does not 
operate normally or exhibits a distinct change in performance. Adjust only those 
controls that are covered by the operating instructions.

■ When storing or transporting the printer, do not tilt it, stand it on its side, or turn it 
upside down; otherwise ink may leak from the cartridges.
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Ink Cartridge Safety Instructions

■ Keep ink cartridges out of the reach of children and do not drink the ink.

■ Be careful when you handle used ink cartridges; there may be ink remaining around 
the ink supply port. If ink gets on your skin, wash it off with soap and water. If it gets 
in your eyes, flush them immediately with water.

■ Do not put your hand inside the printer or touch any cartridges during printing.

■ Install a new ink cartridge immediately after removing an expended one. Leaving 
cartridges uninstalled can dry out the print head and may prevent the printer from 
printing. 

■ If you remove an ink cartridge for later use, protect the ink supply area from dirt and 
dust and store it in the same environment as the printer. Note that there is a valve in 
the ink supply port, making covers or plugs unnecessary, but care is needed to prevent 
the ink from staining items that the cartridge touches. Do not touch the ink cartridge 
ink supply port or surrounding area.
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FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a residential installation. This 
equipment generates, uses, and can radiate radio frequency energy and, if not installed and 
used in accordance with the instructions, may cause harmful interference to radio or 
television reception. However, there is no guarantee that interference will not occur in a 
particular installation. If this equipment does cause interference to radio and television 
reception, which can be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the following measures:

■ Reorient or relocate the receiving antenna.

■ Increase the separation between the equipment and receiver.

■ Connect the equipment into an outlet on a circuit different from that to which the 
receiver is connected.

■ Consult the dealer or an experienced radio/TV technician for help.

WARNING

The connection of a non-shielded equipment interface cable to this equipment will 
invalidate the FCC Certification of this device and may cause interference levels which 
exceed the limits established by the FCC for this equipment. It is the responsibility of the 
user to obtain and use a shielded equipment interface cable with this device. If this 
equipment has more than one interface connector, do not leave cables connected to 
unused interfaces. Changes or modifications not expressly approved by the manufacturer 
could void the user’s authority to operate the equipment.

For Canadian Users

This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.
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Declaration of Conformity

According to 47CFR, Part 2 and 15 for: Class B Personal Computers and Peripherals; 
and/or CPU Boards and Power Supplies used with Class B Personal Computers:

We: Epson America, Inc.
Located at: MS 3-13

3840 Kilroy Airport Way
Long Beach, CA 90806
Telephone: (562) 290-5254

Declare under sole responsibility that the product identified herein, complies with 47CFR 
Part 2 and 15 of the FCC rules as a Class B digital device. Each product marketed is 
identical to the representative unit tested and found to be compliant with the standards. 
Records maintained continue to reflect the equipment being produced can be expected to 
be within the variation accepted, due to quantity production and testing on a statistical 
basis as required by 47CFR §2.909. Operation is subject to the following two conditions: 
(1) this device may not cause harmful interference, and (2) this device must accept any 
interference received, including interference that may cause undesired operation.

Trade Name: Epson
Type of Product: Ink jet printer
Model: B421A
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Epson America, Inc., Limited Warranty

What Is Covered: Epson America, Inc. (“Epson”) warrants to the original retail purchaser 
that the Epson printer covered by this limited warranty statement, if purchased and 
operated only in the United States or Canada, will be free from defects in workmanship 
and materials for a period of one (1) year from the date of original purchase. For warranty 
service, you must provide proof of the date of original purchase.

What Epson Will Do To Correct Problems: Should your Epson printer prove defective 
during the warranty period, please call the Epson ConnectionSM at (562) 276-7525 (U.S.) 
or (905) 709-2567 (Canada) for warranty repair instructions and return authorization. An 
Epson service technician will provide telephone diagnostic service to determine whether 
the printer requires service. If service is needed, Epson will, at its option, exchange or 
repair the printer without charge for parts or labor. If Epson authorizes an exchange for the 
defective unit, Epson will ship a replacement printer to you, freight prepaid, so long as you 
use an address in Canada or the U.S. (excluding Puerto Rico and U.S. Possessions). 
Shipments to other locations will be made freight collect. You are responsible for securely 
packaging the defective unit and returning it to Epson within five (5) working days of 
receipt of the replacement. Epson requires a debit or a credit card number to secure the 
cost of the replacement printer in the event that you fail to return the defective one. If your 
printer is being repaired, Epson will direct you to send your printer to Epson or its 
authorized service center, where the printer will be fixed and sent back to you. You are 
responsible for packing the printer and for all costs to and from the Epson authorized 
service center. When warranty service involves the exchange of the printer or a part, the 
item replaced becomes Epson property. The replacement printer or part may be new or 
refurbished to the Epson standard of quality, and, at Epson’s option, may be another 
model of like kind and quality. Epson liability for replacement of the covered printer will 
not exceed the original retail selling price of the covered printer. Exchange products and 
parts assume the remaining warranty period of your original product covered by this 
limited warranty.

What This Warranty Does Not Cover: This warranty does not apply to refurbished or 
reconditioned products.  This warranty covers only normal use in the United States and 
Canada. Using this product for continuous production or similar high duty purposes is 
not considered normal use; damage, maintenance or service from such use will not be 
covered under this warranty. This warranty is not transferable. This warranty does not 
cover any color change or fading of prints or reimbursement of materials or services 
required for reprinting. This warranty does not cover damage to the Epson product caused 
by parts or supplies not manufactured, distributed or certified by Epson. This warranty 
does not cover ribbons, ink cartridges or third party parts, components, or peripheral 
devices added to the Epson product after its shipment from Epson, e.g., dealer or user-
added boards or components. Epson is not responsible for warranty service should the 
Epson label or logo or the rating label or serial number be removed or should the product 
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fail to be properly maintained or fail to function properly as a result of misuse, abuse, 
improper installation, neglect, improper shipping, damage caused by disasters such as fire, 
flood, and lightning, improper electrical current, software problems, interaction with non-
Epson products, or service other than by an Epson Authorized Servicer. If a claimed defect 
cannot be identified or reproduced, you will be held responsible for the costs incurred.

THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN 
LIEU OF ALL OTHER EXPRESS OR IMPLIED WARRANTIES INCLUDING, BUT 
NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, 
NON-INFRINGEMENT OR FITNESS FOR A PARTICULAR PURPOSE. SOME 
LAWS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES. IF 
THESE LAWS APPLY, THEN ALL EXPRESS AND IMPLIED WARRANTIES ARE 
LIMITED TO THE WARRANTY PERIOD IDENTIFIED ABOVE. UNLESS 
STATED HEREIN, ANY STATEMENT OR REPRESENTATIONS MADE BY ANY 
OTHER PERSON OR FIRM ARE VOID. EXCEPT AS PROVIDED IN THIS 
WRITTEN WARRANTY, NEITHER EPSON AMERICA, INC. NOR ITS 
AFFILIATES SHALL BE LIABLE FOR ANY LOSS, INCONVENIENCE, OR 
DAMAGE, INCLUDING DIRECT, SPECIAL, INCIDENTAL OR 
CONSEQUENTIAL DAMAGES, RESULTING FROM THE USE OR INABILITY 
TO USE THE EPSON PRODUCT, WHETHER RESULTING FROM BREACH OF 
WARRANTY OR ANY OTHER LEGAL THEORY.

In Canada, warranties include both warranties and conditions.

Some jurisdictions do not allow limitations on how long an implied warranty lasts, and 
some jurisdictions do not allow the exclusion or limitation of incidental or consequential 
damages, so the above limitations and exclusions may not apply to you. This warranty 
gives you specific legal rights and you may have other rights which vary from jurisdiction 
to jurisdiction. 

To find the Epson Authorized Reseller nearest you, visit our website at: www.epson.com.

To find the Epson Customer Care Center nearest you, visit epson.com/support.

You can also write to:

Epson America, Inc., P.O. Box 93012, Long Beach, CA 90809-3012
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Copyright Notice
All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or 
transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or 
otherwise, without the prior written permission of Seiko Epson Corporation. The information 
contained herein is designed only for use with this Epson product. Epson is not responsible for any 
use of this information as applied to other equipment.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or 
third parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result 
of: accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to 
this product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation’s 
operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any 
options or any consumable products other than those designated as Original Epson Products or 
Epson Approved Products by Seiko Epson Corporation. This publication and the features described 
herein are subject to change without notice.

Responsible Use of Copyrighted Materials

Epson encourages each user to be responsible and respectful of the copyright laws when using any 
Epson product. While some countries’ laws permit limited copying or reuse of copyrighted material 
in certain circumstances, those circumstances may not be as broad as some people assume. Contact 
your legal advisor for any questions regarding copyright law.

Trademarks

Epson and Epson Stylus are registered trademark, Exceed Your Vision is a trademark, and Supplies 
Central is a service mark of Seiko Epson Corporation. 

Epson Connection is a service mark of Epson America, Inc.

General Notice: Other product names used herein are for identification purposes only and may be 
trademarks of their respective owners. Epson disclaims any and all rights in those marks.

© 2007 Epson America, Inc. 5/07
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